
Using the Visio 2010 Add-in for System 
Center 2012 - Operations Manager 

The Visio 2010 Add-in for System Center 2012 - Operations Manager combines the strengths of two applications 
widely used in enterprise IT to simplify the creation of customized dashboards that show the health of an 
environment. The Visio Add-in lets you create diagrams that show objects by geography on a map, by location in a 
data center or building, by role in a logical view of an application, or by topology for complex distributed 
applications such as Microsoft Exchange Server or technologies such as Active Directory Domain Services.  

The Visio Add-in has the following features: 

 Distributed applications exported from Operations Manager as Visio documents automatically show live 

health state information on the exported objects when opened in Microsoft Visio.  

 You can easily create new Visio documents and link shapes to any managed object (such as a computer, 

database, Web site, or perspective) to show the current health state. 

 You can automatically link entire existing Visio documents to the computer and to network devices 

managed by Operations Manager by matching computer names or IP addresses. 

 Health states can be automatically refreshed in Visio documents. You can use this option along with Visio’s 

full-screen view to create dashboard views suitable for use as a summary display in a data center control 

room. 

 Predefined data graphics enable you to switch from Operations Manager health icons to the shape color for 

health state. 

 NEW - Health states can be automatically refreshed in published Visio documents that are hosted in a 

SharePoint 2010 document library when the Visio Services data provider for System Center 2012 - 

Operations Manager is installed and configured on the SharePoint 2010 Farm. 

The following topics provide information about how to install, configure, and use the Visio Add-in. 

 Install the Visio Add-in 

 Install the Visio Services data provider 

 Configure the Operations Manager Data Source in Visio  

 View a Distributed Application Diagram in Visio  

 Add Links to Operations Manager to a New or Existing Visio Document  

 Change the Way Health State Is Represented  

 Publishing the diagram to SharePoint 2010 

 Building a simple monitoring dashboard using the Visio Web Part 

 Troubleshooting the Visio add-in  

 Troubleshooting the Visio Services data provider 



Install the Visio Add-in 
The Visio 2010 Add-in for System Center 2012 - Operations Manager has the following prerequisites: 

 System Center 2012 - Operations Manager console. 
As an alternative, you can also install the Authoring Console from Operations Manager 2007 R2. 

 Microsoft Visio 2010 Professional or Premium edition 

 Visual Studio Tools for Office 2010 

 The Microsoft .NET Framework 4.0 

When you run the Setup program for the Visio Add-in, your system is checked against these requirements. If your 
system does not meet the requirements, a link is provided so that you can download the missing software. 

To install the Visio Add-in 
1. If you have installed any previous versions of the Visio add-in for Operations Manager 2007 R2, uninstall 

them now. 

2. In Windows Explorer, double-click OpsMgrAddinSetup.msi.  This is the setup for the client. 

If your computer does not meet the prerequisites, you will receive a message that indicates the missing 
requirements. Install the required software, and then run the setup program again. 

3. On the Welcome page, click Next. 

4. Read the license agreement, select I Agree, and then click Next. 

5. Specify the installation location, and then click Next. 

6. Click Next to start the installation. 

7. Click Close when the installation is complete. 

The next time you start Visio, you will be asked if you want to install the Visio add-in. Click Install. When the 
installation is complete, the Operations Manager tab is now available on the Visio ribbon. 

 

  

http://www.microsoft.com/downloads/details.aspx?FamilyID=6c8911c3-c495-4a03-96df-9731c37aa6d7&DisplayLang=en
http://www.microsoft.com/download/en/details.aspx?id=20479
The%20Microsoft%20.NET%20Framework%204.0


Install the Visio Services data provider 
The Visio Services Data Provider for System Center 2012 - Operations Manager has the following prerequisites: 

 System Center 2012 - Operations Manager console or Authoring Console. 
As an alternative, you can also install the Authoring Console from Operations Manager 2007 R2. 

 SharePoint 2010 Enterprise with Visio Services enabled. 

 The Microsoft .NET Framework 3.5 SP1, available from http://go.microsoft.com/fwlink/?LinkID=131605 

To install the Visio Services data provider 
1. Run the OpsMgrDataModuleSetup.msi package by double-clicking on the MSI file. 

 
2. Accept the license agreement. 

 
3. Choose a location for the SharePoint deployment package to be unpacked. 

 
Necessary files are unpacked to C:\Program Files\.. by default.  This can be changed to any location. 
 
FYI – this MSI does not install or deploy the data provider to the servers in the farm.  This MSI just 
unpacks the SharePoint deployment package to a location specified by the SharePoint administrator. 
 

4. Open the SharePoint 2010 Management Shell as administrator 

 

5. Execute the OpsMgrDataModule.ps1 PowerShell script. 

 

This script will install the deployment package to the solution store for the farm and then deploy the data 

module to each of the servers in your farm. 

 

  

http://www.microsoft.com/downloads/details.aspx?FamilyID=6c8911c3-c495-4a03-96df-9731c37aa6d7&DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=6c8911c3-c495-4a03-96df-9731c37aa6d7&DisplayLang=en
http://go.microsoft.com/fwlink/?LinkID=131605
http://go.microsoft.com/fwlink/?LinkID=131605


Example results from running the script… 

 

6. Verify that the package was deployed by executing the get-spsolution command.  After executing this 

command you should see the Deployed column marked as True. 

  



7. Verify the data provider was listed as a Trusted Data Provider for Visio Services using Central 

Administration. 

a. From Central Administration click on Manage Service Applications from the Application 

Management group 

 
b. In the list of service applications click on Visio Graphics Service application link. 

 
c. On the Manage the Visio Graphics Service page, click on Trusted Data Providers 

 

d. In the list of trusted data providers look for the OperationsManagerDataModule as shown in the 

screen shot below.  If this is listed then the data provider for Operations Manager is deployed. 

 

To configure Visio Services for Read-Only Operator permissions on the management server 

In order for Visio Services to refresh the diagrams that are published and connected to Operations Manager data, 
the Visio Services service application must be configured with credentials that have access to the management 
server.  This is because the Visio Services service application is executing the data provider which is responsible for 
returning the updated dataset from the management server. 

The easiest way to configure this is to make the account that Visio Services is running as a Read-Only Operator on 

the management server. 

To do this… 

1. Run the Operations Manager console. 

 

2. From the Administration tab click on User Roles. 

 

3. In the User Roles list double-click on the Read-Only Operators role. 



 

4. Add the account that is configured for Service Application Pool.  
 

 

If you need to determine the account that is configured for Visio Services you can view this using Central 

Administration. 

1. Open the Central Administration site. 

2. Click on the Configure Service Accounts from the Security section. 

3. In the list of Service Accounts choose Service Application Pool – SharePoint Web Services 

Default. 

4. Make note of the account that is configured for this service application. 

5. Click Cancel or close the Central Administration site. 

 

  



Configure the Operations Manager Data Source in Visio 
Before Visio can interact with Operations Manager, you need to configure Operations Manager as a data source for 
your Visio document. You also need to configure the Operations Manager web console address to enable opening 
the Health Explorer directly from Visio. You need to configure these items for each Visio document you create. 

To configure the Operations Manager data source and Web console address in Visio 
1. Open a new drawing in Visio. 

2. On the ribbon, click on the Operations Manager tab, and then click on the Configure button. 

3. In the Name field, type the name of the management server. 

4. In the Address field, type the address for the Web console. This is the console that is used to launch the 

Health Explorer from Visio.  

If you do not know the address, and you have Operations Manager administrator privileges, click Look up 

web console address. If you do not know the address, and you are not an Operations Manager 

administrator, contact the administrator for the address, and then type it in the Address field. 

5. If you want to receive regular updates of state information from the management server, select 

Automatically refresh data, and then specify a refresh interval in seconds. 

6. Click OK. 

 

  



View a Distributed Application Diagram in Visio 2010 
When you export a distributed application from the System Center 2012 - Operations Manager console and then 
open it in Microsoft Visio 2010 with the Visio 2010 Add-in for System Center 2012 - Operations Manager installed, 
the Visio diagram contains information about the health state of each object. This information is provided through 
an automatic connection to Operations Manager. 

To view a distributed application as a Visio diagram 
1. In the Operations console, open your diagram. 

2. On the toolbar, click the To Visio icon. 

 

3. Open the folder in which you want to save the diagram, type a file name, and then click Save. 

4. In Visio, open the exported diagram. 

The add-in automatically contacts the management server when the diagram is opened. 

5. If you are prompted, type the user credentials for the management server, and then click OK. 

When the diagram opens, the External Data window appears in the lower pane of Visio. This window contains 
detailed information about the objects in the diagram, including the health state and the last time the object state 
was refreshed in the diagram.  

You can drill into the status of any object by opening the Health Explorer in the web console. To do this, right-click 
the object and click the Health Explorer hyperlink. Before you can do this, make sure you have configured the 
address for the web console or these links will not be available. See Configure the Operations Manager Data Source 
in Visio for more information.  

Now that you have the initial diagram in Visio, you can customize it by adding new shapes. You can add links to 
Operations Manager components by dragging an object from the External Data window to an image or drawing in 
the diagram. The data is automatically linked to the image. 

  

http://technet.microsoft.com/en-us/library/ee355211.aspx
http://technet.microsoft.com/en-us/library/ee355211.aspx


Add Links to Operations Manager to a New or Existing Visio Document 
The Visio 2010 Add-in for System Center 2012 - Operations Manager lets you create a new Microsoft Visio 
document that you can link to Operations Manager objects. The Visio Add-in also lets you add live health state 
information to an existing Visio document.  

To do this, you first specify the Operations Manager management server from which the Visio add-in will get 
information about the managed objects and their health state. Then, you add the links by using one of the 
following methods:  

 Link a single shape to a managed object. You can quickly link a few shapes to any object managed by 

Operations Manager. 

 Add multiple links to the document and then associate these to Visio shapes later. This option works best 

for large documents that have many different types of managed object. 

 Automatically link shapes in the document to computers and to network devices. This option uses a single 

wizard to automatically add health state information to large and complex network or topology diagrams. 

 Insert a new shape that is linked to an Operations Manager object and that uses the Operations Manager 

icons.  

To link a single Visio shape to an object managed by Operations Manager 
1. In a Visio document, select a shape, click the Operations Manager tab from the ribbon, and then click 

the Link Shape button. 

2. Select the Operations Manager class of the object, such as Windows Computer, to display a filtered list 

of available Operations Manager objects. 

3. Select the object that you want to link to this shape, and then click Link. 

The shape in the diagram now includes a state indicator in the upper-right corner of the image. 

To add multiple links to objects managed by Operations Manager 
1. Click Operations Manager tab from the ribbon, and then click the Add Data Links button. 

2. Select the class from the management server. 

3. Select the managed objects you want to link to this diagram, and then click Insert. 

This will add the selected managed objects to the dataset in the Visio diagram which can be viewed from 

the External Data window. 

4. In the External Data window, select the row for the managed object that you want to connect to a shape 

in the diagram. 

5. Drag the managed object row and drop it on the shape, this will establish the link between the shape and 

that managed object’s record. 

  



To automatically link multiple Visio shapes to Operations Manager managed computers and 

network devices 
1. Open the Visio document. 

Ensure that each shape has defined shape data, such as the Network Name or IP address properties, or 

shape text (such as the IP address of the object). 

To view the shape data for a specific shape, right-click the shape, click Data, and then click Shape Data. 

This opens the Shape Data window that displays the Shape Data fields and values for the selected shape 

in the diagram. 

2. Select all the shapes in the document. 

3. Click Operations Manager tab from the ribbon, and then click Reconcile Shapes. 

4. In the Automatically Link wizard, select Selected shapes or All shapes in the document, and then click 

Next. 

5. Match the Visio shape property to the Operations Manager property. For example, match the Visio network 

name to the Operations Manager display name. The following Operations Manager classes are matched 

automatically: 

 Windows Computer (Microsoft.Windows.Computer) 

 Unix Computer (Microsoft.Unix.Computer) 

 SNMP Network Device (Microsoft.SystemCenter.NetworkDevice) 

Click Next. 

6. Review the list of matches. Click to clear any objects you do not want to link, and then click Next. 

If more than one match is found, click Select to choose the object you want to link to. If no matches are 

found, click Browse to search for the object. 

7. Review the list of links to define, and then click Finish. 

Shapes are automatically connected to the managed objects they represent from the management server. 

To insert a shape that is linked to an Operations Manager object  
1. In your Visio diagram, click Operations Manager tab from the ribbon, and then click Insert shape.  

2. Select the class of the object you want to insert. This filters the available objects to only those of the 

specified class. You can also search for a specific object.  

3. Select the specific object, and then click Insert.  

The new shape is added to the diagram. The shape icon matches those of other Operations Manager objects of the 
same class, and the shape data is populated with information from the management server.  



Change the Way Health State Is Represented 
By default, health state is depicted by using the System Center 2012 - Operations Manager health icons (such as 
the green check mark for a healthy state). You can customize the way that health state is shown by changing the 
Data Graphic associated with the Visio shape. For example, you can show the health state by filling the shape with 
red, yellow, green, or grey color to represent the three health states and to represent a managed object in 
maintenance mode. 

To change the way that health state is represented 
1. Select the shape or shapes that you want to change. 

2. On the Data tab in Microsoft Visio 2010, click Data Graphics.  

3. In the Data Graphics gallery, click the data graphic that you want to use for the selected shape(s). The 

Visio 2010 Add-in for System Center 2012 - Operations Manager includes two data graphics to choose 

from. The SCOM IconSet data graphic shows health state using icons as in Operations Manager. The 

SCOM Color by Value data graphic uses red, yellow, green, or grey color to represent the three health 

states and to represent a managed object in maintenance mode. 

 

Note: In addition to the data graphics that come pre-configured for the add-in you can also create your 

own. 

  



Publishing the diagram to SharePoint 2010 
With the add-in installed on the client and the data provider installed on the SharePoint server you can now publish 
diagrams that you have connected to Operations Manager data to a SharePoint document library to share them 
with others in your organization. 

 

To publish to a document library 
1. From the File tab on the Visio 2010 ribbon, click on the Save & Send option. 

2. Click on the Save to SharePoint button. 

3. Click on the Browse for a location option under Locations. 

4. Under File Types make sure to choose the Web Drawing (*.vdw) option. 

If you do not choose this option the drawing will not be visible using the browser, only the client. 

  



5. Click on the Save As button. 

 

6. In the Save As dialog, choose the name and location for the file.  To browse to a SharePoint server simple 

enter the name of the SharePoint server in the address box and press the Go To button. 

 

Once the diagram is saved to a document library using the VDW file format you can simply browse to the document 

library in your browser and click on the link to the document and the Visio diagram will render in the browser.  

With the data provider installed the data will also be refreshed directly from the management server. 



Building a simple monitoring dashboard using the Visio Web Part 

SharePoint 2010 Enterprise edition also includes a Web Part for Visio Services called the Visio Web Access Web 

Part.  This Web Part can be included on any SharePoint Web Part Page allowing you to build a dashboard that 

includes visualizations using published Visio diagrams. 

To build a monitoring dashboard for your published Visio diagram 

1. Open Internet Explorer. 

2. Navigate to your SharePoint 2010 site. 

3. Navigate to the Shared Documents document library. 

4. Click on the Site Actions menu above the ribbon. 

5. Click on the More Options menu item. 

6. Choose the Web Part page and click the Create button. 

7. Enter a name for this new page. 

 

8. Choose the Header, Right Column, Body layout template. 

9. Click Create to create the new Web Part Page. 

The new Web Part page is opened in edit mode. 

10. Select the Body zone by clicking once on the Body zone.  You should see a new Insert tab displayed 

on the ribbon when you have a zone selected. 

11. Select the Insert tab on the ribbon and click on the Web Part button. 

  



12. From the Categories list choose Office Client Applications and then from the Web Parts list choose 

Visio Web Access. 

 
 

13. Click on the Add button and the Visio Web Access Web Part should be added to the Body zone of the 

Web Part page. 

14. Edit the properties of the VWA Web Part by selecting Edit Web Part from the Edit menu on the Web 

Part toolbar. 

 
 

15. Set the Web Drawing URL property of the VWA Web Part by clicking on the Browse button (…) and 

navigating to the document library where you published a Visio diagram that is connected to 

Operations Manager data.  Select the published diagram and click OK. 

 

16. Set the Automatic Refresh property to 1 minute (1 minute is the minimum value supported).  This 

allows the dashboard to automatically refresh the diagram every 1 minute from the connected 

management server. 

 

  



17. Hide the Open in Visio button by unchecking the Show Open in Visio property in the Toolbar and User 

Interface section. 

 

 
 

18. Click on OK and the changes to the properties of this Web Part will be applied. 

a. You should see the published Visio diagram rendered at this time. 

19. Exit edit mode for this page by clicking on the Stop Edit button on the Edit tab of the ribbon. 

 

 

At this point your Web Part page should be displayed and your published diagram should be rendered within the 

VWA Web Part.  You should also notice that the default Open in Visio button is no longer available from the VWA 

toolbar.   



Troubleshooting the Visio Add-in 
You might see the following issues when you use the Visio 2010 Add-in for System Center 2012 - Operations 
Manager. 

The font size of inserted shapes might appear too small  

When you insert a new graphic by using the Insert Shape option, the font size for the shape text might appear 

too small. The size is determined by the default font size set for a template.  

You can change the font size by selecting the shape and then choosing a different font size in the Visio toolbar.  

Hyperlinks on sub-shapes are not available  

Health Explorer and Alert View hyperlinks might not be available in Edit mode or Full Screen mode if you have 

grouped your shapes or added links to any shapes that were already contained within groups.  

Alert View link is no longer available  

The Alert View link has been removed from the 2012 version of the add-in.  Clicking on the Health Explorer link will 
launch the web console and from the home page of the web console you can select the Alert View link. 

You receive a ConfigurationErrorsException error message 

You might see the following error message: 

System.Configuration.ConfigurationErrorsException: Configuration system failed to initialize --->  

System.Configuration.ConfigurationErrorsException: Unrecognized configuration section userSettings.  

   (C:\Documents and Settings\asttest\Local Settings\Application Data\Microsoft_Corporation 

   \OpsMgrAddin.vsto_vstoloca_Path_logwdvddmizljsrbc2bvt5gtm5juzdix\12.0.6325.5000\user.config       

   line 3) 

. 

. 

. 

 

To work around this problem, delete the configuration file identified at the top of the error message. For example, 

delete the following file:  

\OpsMgrAddin.vsto_vstoloca_Path_logwdvddmizljsrbc2bvt5gtm5juzdix\12.0.6325.5000\user.config 

A runtime error occurred during the loading of the COM Add-in 

After stating Visio you notice that the Operations Manager tab is missing from the ribbon. 

If you navigate to the list of installed COM Add-ins you will see that the add-in is not loaded and that a generic 

error message is given ‘A runtime error occurred during the loading of the COM Add-in.’ 

To view the list of installed COM Add-ins click on the File tab in the Visio ribbon, then select Options.  In the 

Options dialog select the Add-Ins category on the left hand side.  At the bottom of the Add-Ins options page 

change the Manage option to COM Add-ins and then click the Go… button. 

 



The target machine not having the VSTO 2010 runtime installed is a common cause of this behavior.  Please verify 

that the VSTO 2010 runtime is installed on the target machine.  If VSTO 2010 is installed it may be necessary to 

determine the exact error that is causing the add-in to unload. 

In order to view the detailed error that is causing the add-in to not load you will need to set an environment 

variable to tell the VSTO runtime to display loading exceptions.  To do this, edit the system environment variables 

and add a new variable 

VSTO_SUPPRESSDISPLAYALERTS with the value 0 

To do this, click on the Start button and type Environment Variables in the Run box and you should see… 

 
  
In the System Properties dialog, select the Advanced tab.  On the Advanced tab, at the bottom of the dialog, click 
on the New… button.  Set the Variable name field to X and set the Variable value field to 0 as shown… 

 
Click on OK to submit the change and close all the dialogs. 

Restart Visio and look for any new errors to be displayed. 

 

The example error message above points out that the VSTO 2010 runtime is not installed and needs to be installed 

on the target machine to continue. 



You receive a MissingMethodException error message 

You might see the following error message: 

System.MissingMethodException: Method not found: 'System.Security.SecureString 

System.Windows.Controls.PasswordBox.get_SecurePassword()'. 

   at Microsoft.EnterpriseManagement.VisioAddin.EnterCredentials.get_Password() 

   at Microsoft.EnterpriseManagement.VisioAddin.SCOMHelpers.EnterCredentials(ManagementGroupConnectionSettings& 

connectSettings) 

   at Microsoft.EnterpriseManagement.VisioAddin.Document.ConnectToManagementGroup() 

   at Microsoft.EnterpriseManagement.VisioAddin.Document.AddDataLinkToShape() 

 

To resolve this problem, install Microsoft .NET Framework 3.5 SP1, available from 

http://go.microsoft.com/fwlink/?LinkID=131605. 

The state graphic is not displayed 

The state graphic does not appear on a stencil even though you have linked the shape with the Link Shape to 

Data option. 

Some stencils in Visio are not defined with a wrapping group. To resolve this problem, create a group for the 

shape, and then use the Link Shape to Data option again. To create a group, right-click the shape, and then click 

Shape and Group. 

You see security warnings when you open a diagram 

When you open a document that you previously linked to Operations Manager, you receive multiple security 

warnings. 

This problem occurs because the status of the document components is set to refresh automatically. To suppress 

the warnings, select Don’t show this message again. 

You cannot re-install the Visio Add-in 

If you delete the Operations Manager Add-in by using the Visio Trust Center, you cannot add it again later. 

This behavior occurs by design in Visio. Before you can add the Operations Manager Add-in again, uninstall it by 

using Add/Remove Programs (or Programs and Features) in the Control Panel, and then reinstall it. 

  

http://go.microsoft.com/fwlink/?LinkID=131605


Troubleshooting the Visio Services data provider 
If you run into issues using the Visio Services data provider for System Center 2012 - Operations Manager you can 

enable a trace log that will be generated for each user and each of their sessions for only published Visio diagrams 

that are linked to Operations Manager data using the add-in. 

To enable the trace log for the data provider 
1. Edit the config file in notepad and change the location of the log files that will be generated to a location 

on the server or the network that the SharePoint application pool account has write access. 

 

2. Copy the config file to the GAC to the same location as the data provider assembly on each server in the 

farm that has the data provider assembly installed. 

 

The next time a diagram is refreshed this config file will be checked and logs will be written to the location 

that you specified in the config file. 

Each refresh operation will be recorded in a separate log file with the name of the file reflecting the user that 

attempted a refresh and the date and time of the refresh request. 

 

The log file contains the following items: 

 The user name for the user that initiated the request including the date and time 

 The version of the assembly installed on the server 

 The command string that was configured in the diagram before publishing to the server 

 Details about the dataset to be refreshed including table count, row count and IDs for each row. 

 Any error conditions or exceptions that occur within the data module for each session.  

  



Machine Account does not have sufficient permission 

If your SharePoint farm is a standalone installation the machine account will be used instead of the account that is 

assigned to the application pool.  Operations Manager will not allow you to add a machine account to any of the 

roles, so this scenario is not supported for data refresh.  Your SharePoint installation must be a Farm installation. 

 

 

The data provider will not deploy or hangs during deployment 

The deployment script requires that the SharePoint Timer service be started and running.  This service is used to 

queue the deployment jobs to the machines in the farm. 

 

1. If this is stopped the Deployment step in the deployment script could hang indefinitely or return 

with an error.  If this occurs check to make sure that the SharePoint Timer service is started and 

running. 

 

2. Also ensure that the SharePoint 2010 Administration service is running as this service is required 
for the timer service to operate across the machines in the farm. 
http://technet.microsoft.com/en-us/library/ee513051.aspx 

 

http://technet.microsoft.com/en-us/library/ee513051.aspx


An error occurred running the deployment script 

Make sure that you run the SharePoint 2010 Management Shell as an administrator or the script will fail. 

 


